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Proprietary Rights of Business Technology, Inc. (BTi) applications include the following: 

The Attendant Solutions suite of products and related data and information are proprietary 

and confidential to BTi and are the subject of trade secrets and copyrights licensed from BTi. 

The programs and related data and information are provided in confidence. All use, 

disclosure, copying, transfer or storage of these items, except as authorized in the written 

License Agreement from BTi to the user, is strictly prohibited. Information in this document 

is subject to change without notice and does not represent a commitment on the part of 

BTi. 

COPYRIGHTS: 

© 2021 Business Technology, Inc. (BTi). All Rights Reserved. 

301 Mallory Station Rd., Suite 200, Franklin, TN 37067; United States of America 

TRADEMARKS: 

BTi and the Attendant Solutions and individual application logos are registered trademarks 

in the United States of America. 

All other brand or product names mentioned may be trademarks of their respective 

companies or organizations. 
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Preface 

Welcome to the Election Voting Attendant™ 7.5 User Guide. This guide describes the 

features of the Election Voting Attendant™ application. 

Intended Audience 

This guide has been written for System Administrators, News Directors, Lead News 

Producers, News Producers, and Master Control Operators to help in learning the 

functionality available in Election Voting Attendant. 

BTi Technical Support 

Technical support is available to answer questions and to help with any problems 

encountered using the Attendant Solutions suite of products. BTi Technical Support may be 

contacted in several ways: 

Method of Contact Information 

Website www.bti.tv 

Email support@bti.tv  

Voice U.S. 615 591 1900 x1 

We Value Your Input 

We are interested in hearing your comments about this book, particularly if it fell short of 

your needs or expectations.  Please send your comments to support@bti.tv

http://www.bti.tv/
mailto:support@bti.tv
mailto:support@bti.tv
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1      

Introduction 

Election Voting Attendant software is a complete system for automatically configuring, 

capturing, and delivering all local, regional, and national election results to viewers on air, 

online and on mobile devices. Straightforward tools make it easy to prepare the election 

night package far in advance by using early race and candidate details from test data. 

Automatic loading of race details, including candidate information from multiple data 

sources, makes setup quick and easy. 

Regional and national election results are simultaneously captured from a variety of national 

election wire services and web server services. Even local results are automated by capturing 

data from multiple election agency web sites, having it entered remotely by a designated 

official at election headquarters, or by direct input from any workstation in the newsroom. 

Election Voting Attendant automatically switches between sources as needed to ensure the 

most up to date information is delivered to viewers. 

About This Book 

BTi developed this user guide to describe the features of the Election Voting Attendant. It 

consists of the following sections: 

Section Description 

2 – Accessing Election Voting 

Attendant 

Describes how to start Attendant Solutions 

and access the Election Voting Attendant 

3 – Configuring Election Voting 

Attendant 

Describes the EVA Options screen, which is 

used to customize how the Election Voting 

Attendant works  

4 – Configuring Election Details Describes how to create and maintain election 

details using the Maintain Election Details 

screen 

5 – Maintaining Race Details Describes how to use the Races screen to: 

- Add, edit, and delete candidates 

- Customize race parameters 

- View jurisdictions and sources  
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Section Description 

6 – Updating Race Results  Describes how to enter race results manually 

using the Update Race Results screen 

 

7 – Viewing Voting Results Describes how to:  

- View a voting summary by source for a 

specific race 

- Manually set a winner for a specific race 

- Re-evaluate election results 

- View voting details for all data sources for a 

specific race 

- View voting results history 

- Use the Voting Status screen to insert races 

automatically and manually into running 

transmissions and display them on air 

immediately  

8 – Monitoring Elections Describes the monitor process, also known as 

‘Alert Logic for Elections’, which allows the 

building of custom screens for displaying 

election data using a race list. This feature is 

still under development. 

9 – Transmitting Election Results Describes how to: 

- View active transmission jobs 

- Create new transmission jobs 

- Activate transmission jobs 

- Use the Transmission Status screen to edit 

existing transmission jobs  

10 – Viewing Reports Describes how to view and print Election 

Voting Attendant generated reports using 

the Reports screen 
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2 

Accessing Election Voting Attendant™ 

To access Election Voting Attendant, double click the Attendant Solutions icon found on 

the computer desktop. This opens the Login screen. 

Enter your User ID and password and then click Login. Contact your system administrator if 

you do not have an assigned User ID or password. 

The Main Menu screen displays. 

 

Note: The applications displayed on the right of the screen will vary depending upon 

which applications were purchased. 

Click the [Election Voting] button to open the application.  

The menu bar at the top will change to show Election Voting in the drop down list and 

displays buttons associated with the Election Voting Attendant application. 
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3 

Configuring Election Voting Attendant™ 

This section describes the EV Options screen, which is used to modify and customize how 

the Election Voting Attendant works. 

From the Main Menu, choose File > EV Options. 

 

 

 

The EV Options screen will display with the 'State Reporting' tab open. 
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'State Reporting' Tab 

The 'State Reporting' tab is used to select the state(s) for which election data will be 

collected.  

 

To select the states being reported, click the [Edit] button on the right of the screen. 

The EV Options - State Reporting screen will enter the Edit mode showing a list of all the 

states: 

 

Click the check box beside each state which will be reporting. 
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Clicking the [Up] or [Down] buttons will move the selected states into the preferred order in 

which reports will be received. 

'Jurisdictions' Tab 

The 'Jurisdictions' tab is used to set up jurisdiction types so that the system can be 

configured with detailed information on counties and other districts of jurisdiction.  

 

By default, Jurisdictions are not enabled, which simplifies setting up and maintaining the 

application. Votes are then always recorded for the race as a whole rather than the 

individual county. Jurisdictions are most commonly used when a race crosses county or 

other district lines and a source requires individual county / district results for the race to be 

totaled.  

The use of jurisdictions is not recommended for races that don’t meet these criteria. 

To enable Jurisdictions, click the check box at the top left of the screen, which gives access 

to the rest of the screen. 

To set up jurisdiction types, click the [New] button.  

A new row displays in the Jurisdictions (District Types) list.  

Enter a jurisdiction type.  

Click [Save] or press <Enter>. The new jurisdiction type displays in the list. 

To delete a jurisdiction type, simply click the unwanted jurisdiction to highlight it, press 

<Delete> or <Backspace> and then press <Enter> or click [Save]. 

The check box labeled “Utilize Lead Contests in a District to track Voting Percentages” 

should only be checked when the application is tracking the percentage of votes reported 

rather than percentage of precincts reported. In this case, the number of votes cast is 

compared against the expected voter turnout to calculate the percentage of votes reported. 

However, because voters may not vote on all the races on the ballot, a ‘Lead Race’ is 



Election Voting Attendant User Guide 7.6 

Business Technology, Inc. Rev. Aug, 2021 7  

specified and its Votes Cast can be used in place of the Votes Cast for a specific race to get 

a realistic percentage. If in doubt, this box should be left unchecked. 

'Issues' Tab 

Use the 'Issues' tab to set up new issue types and issue responses. 

To set up new issue types, click the [New] button beneath the 'Types of Issues' list. 

 

A new blank row will display in the list.  

 

Enter an issue type and click [Save].  

To set up an issue response, click the [New] button under the Issue Responses list. 
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Enter the "For the Issue" response and the "Against the Issue" response.  

 

Click [Save].  

 

'Race Parameters' Tab 

The 'Race Parameters' tab allows the user to add parameters to each race which relate to 

the station's specific installation. These parameters are typically used to control or direct the 

airing of election information.  

To add a race parameter, click the [New] button. 

 

A new row and parameter number are added to the Race Parameter list.  

Enter the title of a race parameter. The actual parameter is entered in the Races screen or 
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from another data source.  

Click [Save]. 

 

'Candidate Parameters' Tab 

Like the Race Parameters tab, the 'Candidate Parameters' tab is used to add parameters to 

each candidate which relate to the station's specific installation. These parameters are 

typically used to control or direct the airing of election information. 

 

 

To add a candidate parameter, click the [New] button. 

A new row and parameter number is added to the Candidate Parameter list. 

Enter the title of the candidate parameter. The actual parameter is entered when editing 

Candidates in the Races screen, or from another data source. 

Click [Save]. 

The "Adjust Candidate Percentages..." checkbox offers the option of rounding the candidate 

vote percentages so that they will equal 100. Normally, this box is not checked. However, in 

some cases the user may want to have this box checked, especially if there are only two or 

three candidates in the race.  

Since the rounded values are not the absolute values, this setting should be used with 

caution. 
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'Reset' Tab 

The 'Reset' tab is used to reset a variety of information about the current election. It is 

primarily used to clear all historical voting results about an election in preparation for a test. 

It should ALWAYS be used prior to collecting the election results on election night. 

 

 

 

Reset Election Results - This section shows the number of races, candidates, and results 

currently on file for the active election. There is also an indication of when the last reset 

occurred. 

 

To reset the election results, click the [Reset] button.  

 

Confirm the action to be taken. The results are cleared but all race and candidate 

information is left intact. 

Reset Race Winner Manual Override Flags - This section shows how many races are 

currently set for manual control. Here the user may review and clear the setting which 

permits manually marking the winner of a race. Each race offers the option for Manual 

Override to prevent another data source from declaring the winner. This setting can be 

retained for the next test or for election night if needed.  

To reset the manual override flags, click the [Review] button. The screen will then display the 

races which have been set for manual control.   
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Click the [Reset] button to clear all the settings for the races displayed, or click the 'Reset' 

tab at the upper right to cancel the action. 

Clear District Override Percentages - Where Jurisdictions are in use, the expected voter 

turnout is calculated by summing the expected voters in each county using the voter 

turnout percentage provided by the County Election Commission. It may be that on election 

night, more or fewer voters are participating in the election in a particular district, so an 

override percentage can be specified.  

To clear these percentages, click the [Clear] button.  

Confirm that all percentages should be cleared. 

Testing - Click the “Air Races with No Votes” checkbox to allow the application to show 

races in which no votes have been reported or entered.  

This option is most often used for testing the setup of the character generator displays.  An 

alert indicating that all votes are being aired is shown on the Status screen to ensure that 

the setting is cleared on election night.  

Refresh Election Bridge Results - If the station has subscribed to Election Bridge, this button 

will refresh the results of ALL races in Election Bridge, not just the latest changes. 

 

'Statistics' Tab 

The 'Statistics' tab shows details about the server computer being used. These details 

include the server name and operating system, the SQL engine, and a count of records 

contained in the files. 
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'General' Tab 

The 'General' tab gives the option to choose the method of updating applied when entering 

election data and displays the path to the Central Repository for Web Capture worksheets. 

 

 

The choice of which update method to use when data is entered depends upon how many 

workstations or mobile devices are being used for reporting. If more than five entry stations 

are being used, Background Updating should be chosen, which writes the data to a file 

before processing.  

If Web Capture is being used, the default path to the Central Repository for Worksheets is 

entered and can be edited here. See the Web Capture User Guide for more details. 
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4 

Configuring Election Details 

Election details are created and configured using the Maintain Election Details screen and 

then may be saved for use in other elections. Once an election has been created, it must be 

configured. Configuring an election involves setting up election details, contests, and data 

sources.   

There are four main steps to configuring an election using the Maintain Election Details 

screen: 

1. Click [New], enter the election name and date, then click the “Active” checkbox to 

make it the active election. 

2. Ensure all the contests are set up. These include the offices being contested and 

any referendums, amendments, propositions, or other issues included on the ballot.   

3. Check the data sources, link them to the appropriate races, and auto-load any race 

data. 

4. Test the election setup as much as possible, from the gathering of data to the 

display of on-air data. 

Maintaining Election Details 

To access the Maintain Election Details screen, click [Setup] or select Edit > Setup Elections. 

 

 



Election Voting Attendant User Guide 7.6 

Business Technology, Inc. Rev. Aug, 2021 14  

The Maintain Election Details screen displays. 

 

The Elections list in the left panel shows all elections created to date.  

The following table describes the Maintain Election Details screen elements: 

Active Indicator displaying status for the current election: "Active", “Past”, or 

“Future” 

Date of 

Election 
Date the election is scheduled 

Name Name of the election 

Time Polls 

Open / Close 
Time of day the polls open and close 

Notes Comments associated with the election. These comments will not be seen 

on the air. 

[Contests] Sets up the offices, referendums, propositions, amendments, etc. and 

identifies which are to be included in the current election. 

[Data Sources] Wire services, websites, and manual entry data sources from which the 

election results are obtained 
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[Districts] Demographic information on counties (or other reporting units) and 

districts. 

[Set Up Lists] Lists of contests are built for use throughout the application. 

 

Adding Elections 

From the Maintain Election Details screen, click [New] under the Elections list. 

The Maintain Election Details screen changes to New mode.  

Three additional buttons now appear under the 'Notes' window. 

 

 

Enter the date of the election, name of the election, the times that the polls will open and 

close, and add notes as needed. 

Click the [Mark as the ACTIVE Election] button to set the current election as the active 

election.  Election results can only be entered and aired for the active election. 

Click [Save] to create the new election. 
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Editing Elections 

From the Maintain Election Details screen, select the election to be edited. 

Click [Edit]. The Maintain Election Details screen changes to Edit mode.  

The same options as in the New screen will become available. 

After making changes, click [Save]. 

 
 

Deleting Inactive Elections 

From the Maintain Election Details screen, select the election to be deleted.  

 Note: The “Active” election cannot be deleted. 

Click [Delete] and confirm by clicking [Yes]. 

Setting Up Pre-Election Information 

When election details are being set up for the first time, the user must determine the 

general information pertaining to the specific way the elections will be handled.  

Districts of Jurisdiction - Depending on the level of incoming election results available from 

the data sources, it may be desirable to set up the reporting units (individual counties, 

wards, or parishes) that report election results. In this case, all the individual voting districts 

for each jurisdiction can also be created, along with the number of registered voters and 

precincts from each county, ward, or parish.  
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Note: The use of reporting units is recommended only when a race crosses jurisdiction / 

district lines and a source requires individual jurisdiction / district results for that race. For 

more information on setting up jurisdictions see Chapter 3, 'Jurisdictions' tab. 

Contests – Races in an election may be for an Office (a job position or title) or an Issue (to 

get a For or Against opinion).   

Offices: Typically the details of an office are the same from one election to the next and 

Election Voting Attendant retains this information. This includes information such as 

how to display the name on-air and on the web site, as well as the number of winners if 

more than one candidate is being elected for the same office (such as city council). 

Once the office details have been set up, they are assigned to the election so that 

candidate information can be loaded. 

Issues:  Referendums, Amendments, Propositions, and Initiatives are considered one-

time events and are automatically removed if and when the election is deleted. The 

available voting options ‘For / Against’, ‘Yes / No’, ‘Pass / Fail’, etc. are assigned 

automatically when an Issue is assigned to the election. 

Note: Each office may optionally be assigned to a district of jurisdiction, if that level of 

detail is being set up. A district of ‘USA’ is used by default. 

Setting Up Reporting Units  

A data source provides race results based on a reporting unit. Some data sources report on 

the race as a whole, but some provide data at a more detailed level such as by county, ward, 

or parish. To match the incoming data in these cases, each reporting unit must be identified. 

To set up a reporting unit, click the [Districts] button on the Maintain Election Details screen.  

Note: The [Districts] button will be disabled (grayed out) if Jurisdictions have not been 

enabled in EV Options. See Chapter3, 'Jurisdictions' tab. 
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The Set Up Reporting Districts screen displays. In the ‘States Covered’ list box on the left of 

the screen, states are shown in the order selected as described in Chapter 3. Each state in 

the list needs to be set up separately. 

 

 

When the state is selected, the “Reports By” field populates with the appropriate reporting 

unit information. The total number of precincts, number of registered voters, expected 

number of voters, and average percentage of voter turnout fields reflect the total counts 

based on the counties listed for each state. 

To add a new entry, go to the last row in the county list and enter the name, number of 

precincts, number of voters, and expected turnout percentage. 

Tab through each of the entries, or select another line to populate the expected turnout 

from the entries made.  

To edit an item, highlight the text in the grid which is to be changed and enter the new 

values. 

To delete an item, highlight the County Name to be deleted, press the <Delete> key, then 

press the <Tab> key. When asked to confirm the deletion, click [Yes]. 

If the station subscribes to API as a data source, the button [Update Counties from Data 

Source] at the lower left of the screen may be used to automatically fill in any fields for 

which API has data. 
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Setting Up Districts  

Districts can consist of the voters from an entire reporting unit, as in the case of County 

Districts, or they can consist of a mix of voters from a number of different counties as in the 

case of many Congressional Districts. These districts are often reconfigured after a census 

and the system allows the user to easily update this information and have it flow 

automatically to each of the contested offices. 

A district called "USA" under the state "United States" is automatically created and it is used 

as the default district when a new contest is added. 

To set up districts, click the 'District Setup' tab on the Set Up Reporting Districts screen. 

 

 

 

Choose a State and Type of Jurisdiction to filter the list of districts.  
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Adding a District 

To add a new district within a jurisdiction type, click the [New] button.  

(Note: The [New] button will not function unless a specific type of jurisdiction is selected.) 

The District Setup tab changes to ’New’ mode, indicating that a district is being added. 

 

 

 

Enter a new district name in the "Name" field at the upper right. 

Click the check box(s) to choose the counties within this district. The space bar may also be 

used to fill or clear the checkboxes. Bear in mind that a district may include part of a county 

and not the whole county. It may also include more than one county. 

Click [Save]. 

The name of the new district will appear in the list of districts. 
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The Voters group box displays the voter counts for the selected district. 

  

 

In the example above, two counties were selected within a city district, but only a small 

portion of the voters in those counties are a part of the city district being set up. To adjust 

this, click on the [Voters] button. 

The Set Up District Voting screen displays.  
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To correct the voting information relating to this district, edit the information in the yellow 

columns. 

 

 

 

The expected turnout is applied to the number of voters from each county to show the new 

voting figures for this district, including the revised Expected Turnout. 

The Expected Voting Percentage for this District can also be set manually if needed by 

clicking the "Override %Voters" check box and entering a specific percentage. 

Click [Close] to return to the Set Up Reporting Districts screen and display the updated 

figures for the district.   

 

Note: The ‘#’ sign is placed after the number of voters from each county in the County 

Units in this... District list box to indicate that the county numbers have been adjusted for 

the district. See the figure below. 
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The option to "Override Registered Voters..." is used in a case where the actual number of 

votes entered may exceed the number of registered voters reported by the election officials. 

(This feature is used very rarely.) 

The "Lead Contest..." text box is used to specify which contest will be used to determine the 

percentage of votes reported.  

 

Note: None of the "Lead Contest..." text will appear on the screen unless the "Utilize Lead 

Contests..." option is chosen in EV Options > Jurisdictions. Refer to 'Jurisdictions' tab in 

Chapter 3 for details. 

 

Editing a District 

To edit a district, select the district to be modified and click [Edit].  

The District Setup screen changes to 'Edit' mode. 
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The same procedures are used as when adding a district. 

After making changes, click [Save]. 

 

Deleting a District 

To delete a district, select the district to be deleted and click [Delete].  

To confirm the deletion, click [Yes]. 

Click [Close] to exit the screen. 
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Setting Up Contests 

From the Maintain Election Details screen (Main Menu > Setup), click the [Contests] button. 

 

 

The Maintain Contests screen will display. 
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The Contest Grid 

On the left side of the Maintain Contests screen is the contest grid. Any of the column 

headings can be used to sort the contests. The grid contents can be filtered by selecting a 

particular contest list from the dropdown box at the top of the screen. (To set up lists, see 

"Maintaining Lists for On-Air Display" later in this chapter.)  

The contests may also be filtered by selecting any of the 4 checkboxes. Additionally, any 

particular contest may be found by clicking the [Find] button and typing in part of its name. 

The check boxes allow selection of Offices and/or Issues (Other Contests), as well as 

showing only contests in the current (Active) election. Contests in the Active Election are 

shown in blue.  

If the “Show Active Election Only” box is not checked, all contests currently in the database 

are listed. 

Disabled contests are not shown unless the “Include Disabled Offices” box is checked. 

Details of the selected contest are shown on the right side of the screen. Along the bottom 

are some additional options described later in this chapter. 

The columns in the grid are described below. 

 

Typ 
The type of contest.  A lower case ‘o’ represents an Office, whereas Issues 

are represented by the first letter of the issue type, capitalized. 

Grp The group (if any) assigned to this race.   

R# If a Race number has been assigned, then it is shown in this column.  

Contest The name of the contest. 

<reset> This button resets the order of contests to its base sequence. 

 

Adding a New Contest 

To add a new contest, click the [New Contest] button at the bottom of the screen. 
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The Maintain Contests screen will change to the 'Add' mode. 

In the Contest Details group box, enter the name of the office or issue, the jurisdiction, the 

district, and the type of contest. 
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The Jurisdiction is set to ‘USA’ by default. This simply means that the contest has been 

assigned to the default district. If the contest is assigned to another district, then the 

number of voters and precincts will be taken from that district. 

To assign this contest to a district, click inside the "Jurisdiction" field.  

This will display the Assign this Contest to a District screen.  

 

 

Choose a State and Type of District to filter the list of available districts. 

Select the district to which this contest will be assigned, click [Apply] and click [Close]. 

Optionally, double-clicking a district will assign a district and close the screen. 

 

Back on the Maintain Contests screen, select the type of contest being added. The types 

would include Office, Referendum, etc. plus any items configured from the EV Options 

screen. (See Page 7.) 
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A group code may be entered. This simply allows the contests on the left of the screen to be 

grouped in order, rather than using a list. 

The number of voters and precincts in the contest is based on the district to which it is 

assigned. The number of precincts is overridden here; this would be the case if no districts 

had been set up or if election results will be entered manually.  

Note: If a race is being reported only by percentage of precincts, this number should be 

100. 

Enter the number of winners for this contest. The default is one. 

If the contest type is anything other than Office, a "Pass%" box will display. This indicates the 

percentage of votes required for the issue to pass, depending upon state regulation. The 

default value is 50%.  

(Note that this figure is only for the transmission; it does not declare the outcome of the 

contest.) 

Enter the 'On Air Names' as needed. 

Click [Save]. 

 

The contest is added to the end of the contest list. The order of contests may be arranged 

by highlighting an entry and dragging the border of the item to its new location. A black 

border indicates the new position of the item until the mouse button is released. 
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Configuring On-Air Titles 

The names of the contests used within the system are often abbreviated to ensure they fit 

on the display screen properly. One part of the pre-election setup is to specify what the 

titles for each contest should be on air.  

The following process sets up the descriptions for the contest titles, both on- air and on the 

station's web site.  

From the Maintain Election Details screen (Main Menu > Setup), click the [Contests] button.  

 

The Maintain Contests screen displays; double-click anywhere in the Titles list.   

 



Election Voting Attendant User Guide 7.6 

Business Technology, Inc. Rev. Aug, 2021 31  

 

The Configure On-Air Titles screen displays. 

 

Enter descriptions or prompts such as “Lower Third Header” or “Full Page Header” as 

needed. The same header may be used in multiple places.  

Enter a value for the maximum number of characters allowed for each office title. The 

standard maximum number of characters is 50. 

Click [Close] and confirm that the titles are updated. On returning to the Maintain Contests 

screen, the new titles are now shown in the list of titles for On Air Names. 

Finding a Contest 

Click the [Find] button at the top of the Maintain Contests screen to open the Find Window. 
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Type characters into the top box. As the characters are typed, the list of contests shown will 

be reduced to only those containing that sequence of characters in the contest name, as 

shown below. 

 

Click the contest to be displayed. The screen will return to the Maintain Contests screen 

showing the details of the selected contest.  

 

Editing / Deleting Contests 

To edit a contest, select the contest to be edited from the list on the left. By default, the list 

on the left shows all contests that have been set up. However, contests can be grouped into 

lists and any of those lists can be displayed by choosing it from the drop down box above.  

Edit the item that needs to be changed by clicking the field to be changed and entering the 

change. The screen will automatically enter the Edit mode and the [Save] and [Cancel] 

buttons will be displayed to allow the change to be recorded or not. 

A contest may be disabled by clicking the [Disable Contest] button. If a contest has been 

disabled, it may be re-enabled by clicking the [Enable Contest] button. 

To delete a contest, select the contest to delete and click [Delete Contest]. A warning will 

appear. Confirm by clicking [Yes]. 

Caution: When a contest is removed, any related candidate information is deleted unless 

candidate details have been retained. See Pages 74-75. 

If a contest is any type other than 'Office', all related information will be deleted. 
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Setting Up Contest Lists 

Contest lists are useful for facilitating several operations in the application. Lists offer a way 

of grouping contests to better suit the user, rather than just using a group code.  

To set up lists of contests, click the ellipsis button [...] to the right of the Lists drop-down box 

at the upper left of the Maintain Contests screen.  

The Set Up Lists screen displays. For more information on setting up lists, see “Maintaining 

Lists for On-Air Display” later in this chapter. 

 

Assigning Contests to an Election 

When a contest is first added, it is automatically included in the current election. Four years 

later, or whenever the office is contested again, the contest details are usually still available 

in the application. This allows for adding contests which are still on file to the current 

(Active) election. 

 

Terminology: When a Contest is included in an Election it becomes a Race, and this 

terminology is used throughout the application. A Contest is the name of an elected job 

position or the name of a Referendum, Proposition, etc., with details about that contest. A 

Race, however, has one or more candidates or a selection of responses (For/Against, 

Yes/No, etc.) and is linked to a specific Election. 

 

To assign a contest to the active election, click [Assign to Election] at the bottom of the 

Maintain Contests screen.  
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The right side of the screen changes to show the list of races already in the election. 

 

Select one or more contests from the left side of the screen using <Shift>-Click to select a 

range, or <Ctrl>-Click to select multiple contests. The selected contests will be highlighted 

in yellow. 

Click the [>] button under 'Add selected Contests to the Election'. 
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The selected contests are added to the bottom of the list of races in the election and the 

[Update Election...] button is highlighted as shown below. 

 

 

 

Click the button [Update Election with the new Race List] to implement the changes made, 

or click [Cancel] to abort all the changes. The program then returns to the Maintain Contests 

screen. 

Races can also be removed from the Election using this screen.  

 

Caution: When a race is removed, any related candidate information is also deleted unless 

candidate details have been retained. See screen on Pages 74 and 75 

. 

• Tip:  When building the list of races for an Election, it is very easy to use Lists to add a 

whole group of contests at one time, rather than picking and choosing individual 

contests.  

 

To do this from the Maintain Contests screen, select one of the lists to be included 

(from the drop-down box at the upper left), then click  [Assign to Election].  Only the 

contests in that List are now shown on the left side of the screen.   

Select the first contest in the list, then the last contest with <Shift>-Click to select all the 

contests.  Then click [Add selected Contests to the Election] and [Update Election...].  
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      This process can be used for multiple lists to build the entire Election.  

      For more detail on creating lists, see the following page. 

[Go To Race] button 

Once a contest has been added to the election, the [Go to Race] button becomes available. 

This button will switch to the Races screen, highlighting the same contest.  

 

The Races screen has a corresponding [Go To Contest] button that switches back to the 

same Maintain Contests screen again. (See Chapter 5, [Go to Contest]) 

Thus, the two buttons act as a toggle to switch between the two screens, showing the 

details of the selected contest in each screen. 

 

 

Maintaining Lists for On-Air Display 

Grouping contests into a list makes for easier entry of race results and allows groups of 

races to be quickly moved on and off air.  A race can appear in many different lists and 

multiple times in the same list. For example, State Senate District 2 can appear in the State 

Senate list and also in the Hot Races list. 

Using the Set Up Lists screen, lists may be added, edited, copied, and deleted. 
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Adding Lists 

To add a new list, begin at the Maintain Election Details screen and click the [Set Up Lists] 

button at the bottom of the screen.  

Note: If a user has been given rights to access this information, then this option is also 

available from any screen which allows the selection of a list by clicking the ellipsis button 

[…] to the right of the list name. 

 

The Set Up Lists screen displays. Click [New].  
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The Set Up Lists screen changes to the ‘Add New List’ mode. 

 
 

Enter a list name at the upper right. 

At the upper left, choose what contests to show by clicking the “Show All Contests” option 

or the “Show Active Election only” option.  

 

Clicking a contest on the left will move it into List Elements on the right. Contests can 

appear multiple times in the list.  
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Note: When a race list is put on air, the races appear in the order in which they are 

arranged in List Elements. See the next page for instructions on rearranging the list. 

Click a List Element on the right to remove it from the list.   

Click [Save] to save the list. 

Editing / Deleting Lists 

From the Set Up Lists screen, select the list to be edited. 

Click [Edit]. The screen changes to allow editing the List Elements in the same manner 

described above.  

Click [Save] after changes are made. 

To delete one or more lists, select one of the lists to delete, and click [Delete]. 

The screen allows the selection of multiple lists by using the <Ctrl> and <Shift> keys in 

conjunction with clicking. Click [Add to Deletion List] to move the selected lists over to the 

deletion list.  

To remove a list from the Deletion List, simply click it.  

 

 

After reviewing the choices, click [Confirm Deletion] to delete all of the selected lists. 

Resequencing Elements in a List 

Resequencing the elements in a race list changes the order in which they will appear on air. 

The list elements may be sorted by clicking [Edit] and clicking the column headings ‘#’ 

(sequence number), ‘R#’ (race number), or alphabetically by List Element. 
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If a different order is required, use the following procedure. 

From the Set Up Lists screen, click [Re-Seq]. 

 

Select the list to resequence. 

Highlight the list element on the right and then drag its border to its new position. A black 

border indicates the new position of the item until the mouse button is released. 

 

Another list may be selected to resequence while on the same screen.  

Click [Finish] to exit the ‘Resequence Lists’ mode. 
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Creating Lists Based on Existing Lists 

To create a race list for on-air display based on an existing race list, the existing list is copied 

and then modified.  

To do this, start at the Set Up Lists screen, select the race list to copy, then click [Copy].  

 

Confirm whether or not to create a copy of the existing list.  

 

 

The screen changes to 'Copy' mode. 

 

Enter a new race list name at the upper right.  

At the upper left, choose what contests to show by clicking the “Show All Contests” option 

or the “Show Active Election only” option.  
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Click any available contest to move it to List Elements.  

Click a List Element on the right to remove it from the list. 

Note: When a race list is put on air, the races appear in the order in which they are 

arranged in List Elements. To rearrange the list, see the above section on resequencing the 

elements in the list.  

Click [Save] to save the new list. Another list may now be created, edited, copied, or deleted.  

Click [Close] to exit the screen. 

Maintaining Data Sources  

Data sources represent the different sources from which data is gathered. Examples of data 

sources include wire services, web services, web pages, and manual entry. 

A data source provides race results based on a reporting unit. Usually this is based on the 

race as a whole, but can also be provided by county, ward, or parish. To match the incoming 

data in these cases, each reporting unit must be identified. 

Using the Data Sources screen, a user is able to add, edit, and delete data sources, enable or 

disable data sources, edit the list of races being monitored by a specific data source, and 

load races.  

To work with data sources, click the [Data Sources] button on the Maintain Election Details 

screen. 

 

The Data Sources screen displays with the first tab open, which bears the same name as the 

currently selected Data Source. 
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The list on the left displays the total number of data sources as well as the number of 

enabled data sources. The “Show All” check box gives the option of showing both enabled 

and disabled data sources. 

The following table describes the Data Sources screen elements. 

 

Source Type Type of data source. The different types of data sources are 

configured when the system is installed and include all the sources for 

which data captures have been programmed. 

Description Description of the data source 

State The state for which this data source applies, if applicable 

Reports By How data for this source is reported and is set when the data source 

is created. "Race" is the default value and the other options are 

determined by the state. It is "County" in most cases, but may be 

"Parish" (Louisiana) or "Ward".   

Story ID The prompt for this entry is configured based on the data source. For 

the BTI Web Data Capture, this prompt is the ‘Group Code’ and is 

related to how the user sets up the data capture process.  
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“Set Race 

Winner...” 

This checkbox gives the option of accepting or ignoring any winner 

indicators from the source. If left unchecked for all sources, the 

winner declarations must be handled manually within the application. 

“Replace the 

Precincts 

Override...” 

When this box is checked, the source will override the number of 

precincts originally entered with its own number of precincts. 

“Increment 

Vote 

Counts...” 

Checking this box will allow the system to automatically increment 

the number of votes while in the testing mode. When a reset is 

performed before the election, this box will be cleared. 

Notes Any comments associated with this data source. This is particularly 

helpful for manual entry situations to guide the user in entering data 

Races The Races area indicates the number of races that are active for this 

data source and provides the choice to load race details from data or 

a spreadsheet. 

 

Adding Data Sources 

To add a data source from the Data Sources screen, click the [New] button at the bottom of 

the list of sources. 

 

The screen will change to the "Add" mode. 
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Choose the data Source Type from the dropdown list.   

Note: The types of data sources are configured by BTi when the pre-installation 

information is received from the station. 

 

The chosen data source type displays in the "Source Type" field. 



Election Voting Attendant User Guide 7.6 

Business Technology, Inc. Rev. Aug, 2021 46  

 

Note: This screen may present different options depending upon the source type chosen. 

Enter a description of the data source. This defaults to the Source Type, but it is suggested 

that a more descriptive name be used. No two sources can have the same description. 

Select the "State" from the drop-down list, or select United States if data is being received 

for multiple states. 

Choose how the data source is reported, such as by Race (default) or by County from the 

drop down list. This list is reconfigured based on the State selected. 
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If the source type is an Excel Data Capture, specify a Group Code, if needed. All source 

group codes must be unique. 

Leave the Story ID blank, if present, unless there are specific instructions otherwise. 

By default, the “Set On-Air Race Winner if Declared by this Source” check box is not 

checked. Check this box to give this source control over declaration of the winner. 

The “Replace the Precincts…” box gives the option of allowing the source to provide the 

total number of precincts. 

The “Increment Vote Counts…” box is optionally used during testing to ensure that vote 

counts are being updated. 

Optionally, add any additional notes or comments as needed. 

Click [Save].  

 

Editing / Deleting Data Sources 

To edit a data source, first select the data source to be edited. 

If clicking a field produces a blinking cursor, that field may be edited.  

When any change is made in one of those fields, or if one of the checkboxes is changed, the 

screen will automatically change to Edit mode. 
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Make whatever changes are needed.  

 

Enable or disable a data source by clicking the "Disable Source" box. 

Note: Disabling a data source means that any data from this source is discarded. There is 

a ‘Hold’ feature (described in the next section) that can be applied to a particular race for 

a data source. This feature captures and logs the data that is received but does not 

include it in the evaluation process for determining the on-air results.  

Click [Save] when the changes have been made. 

To delete a data source, select the data source to be deleted, and click [Delete].  

When asked to confirm, click [Yes].  

The 'Load Races...' buttons will be described later in this chapter, pages 57-69. 

 

Assigning Races to a Data Source 

When a new data source is set up, all the races in the current election are assigned to it by 

default. (Note that races whose results will be included in that data source must be loaded 

and linked - see page 57.) 

While this practice keeps things simple, it is much more efficient to identify the races to be 

gathered from each data source. This allows the Data Consistency Check (described in the 

next chapter) to be much more meaningful.   

For example, local city races are not likely to be covered by the AP service, so there would 

be no match codes entered. The Data Consistency Check would see this as an exception 

because all AP races need a code to match with the data. 

To access the screen showing the races assigned to a data source, start from the Data 

Sources screen (Main screen > [Setup] > [Data Sources]), choose the appropriate data 

source from the list, and select the ‘Applicable Races’ tab for that data source. 

The main part of the Races screen shows the list of races for this data source. 
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The list of races is made up of the following columns and, apart from the race name and 

Hold status, all the details can be changed from this screen. 

 

Race The Race name 

Active A blue checkmark indicates the race is active for this data source. 

MatchCode1 The primary match code for the race for this data source. 

MatchCode2 The secondary match code for the race for this data source, if applicable.  

In the case of a wire service bulletin with multiple races, the primary match 

code would be set to the story slug, and the secondary match code would 

be the race name within the story. 

Hold A red ‘HOLD’ indicates that a race is on hold, and while its results are 

being captured, the voting figures are being ignored for the moment. 

Other races from the data source are not affected. 

The rest of the screen is made up of the following elements: 

Alert An alert, in red, at the top of the screen if any race match codes are 

missing. Only Active races are counted 
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"Show All Races" By default, this checkbox is unchecked, so only races being 

monitored are displayed. Checking the box will allow more races to 

be displayed in the list, including disabled races. If checked, 

additional buttons are available to allow all races to be included or 

excluded from this data source. 

Number of 

Active Races 

The number of races that are active for this source. No data is 

monitored or collected for races that are not active. 

Number of 

Races on Hold 

The count of Races that are ‘On Hold’. Data is collected for races 

that are on hold, but the results are not included in the evaluation 

process for the latest voting figures. This setting may be used on 

election night to temporarily ignore some bad voting results, and 

can be set from the ’Latest Votes’ tab, explained below. 

Set/Clear Match 

Codes… 

These buttons provide a way to quickly fill in or clear the match 

codes for all races in the list. 

[Refresh] This button updates the screen with the latest changes. 

[Back] This button returns the screen to the home screen of the selected 

data source. 

Click [Back] to exit this screen and go back to the main Data Sources screen. 

 

Placing Races on Hold 

When a race is placed “on hold”, data is still collected from that race, but its results are not 

included in the overall tally of votes. This may be necessary on election night if bad voting 

results are apparent and need to be temporarily ignored. The results for that race will not go 

to air. 

To place a race on hold, choose the appropriate data source on the Data Sources screen, 

and go to the ‘Latest Votes’ tab for that data source. 
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In this case, the race for Davidson County Sheriff has been placed on Hold by clicking the 

[Exclude] button in the ‘AP_API Service by Race’ data source. The status is shown on this 

screen as well as in the Hold column on the ‘Applicable Races’ screen, as shown in the 

previous section. 

Clicking the [Include] button for that race will restore its status to normal. 

Options are given to Include or Exclude all races. 

Click [Back] to return to the main screen for the data source previously selected. 

 

Assigning Reporting Units to a Data Source 

Note: This section does not apply to any data source which is reporting by Race.  

When a new data source is set up which is reporting by County, Parish, or Ward, the specific 

reporting unit should be identified. 

By default, all the Counties or other reporting units are assigned to the data source, which 

may or may not be necessary. Similar to the previous section on the Races being monitored, 

it is much more efficient to identify the specific Counties to be gathered from each data 

source. 

To assign reporting units to a data source, open the Data Sources screen (accessed from the 

Main screen > [Setup] > [Data Sources]) and select the data source to be reviewed from the 

list on the left. The data source would need to be one that reports by County or other 

detailed reporting unit.  
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The data source information is displayed and there is now a ‘Reporting Units’ tab included 

on the screen. The number of active units is shown along with the number of precincts and 

registered voters reported. 

 

Click the ‘Reporting Units’ tab to display the Reporting Units screen. 
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The screen is made up of the following elements: 

List of 

Reporting 

Units 

The list of Reporting Units currently being monitored by this data 

source, with a variety of columns described below. 

Number of 

Reporting 

Units being 

monitored 

This number will change as the number of Active units changes. 

"Show All 

Units" 

By default, this checkbox is unchecked, so only reporting units being 

monitored are displayed.  Check the box to show all units. If checked, 

additional buttons are available to allow all units to be included or 

excluded from this data source.   

To edit the Reporting Units being monitored, click the "Show All Units" check box near the 

bottom of the screen.   

The following screen is displayed, which adds two additional buttons, [Select All] and  

[Select None]: 

 

Note that the number of units assigned (monitored) has changed as shown at the lower left. 

The list of reporting units is made up of the following columns: 
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Unit Name The name of the reporting unit. The column headings vary based on the 

type of reporting unit – County, Parish, and Ward. 

#Prec The number of precincts in the reporting unit 

#Voters The number of registered voters in the reporting unit 

Active A checkmark is present if the reporting unit is being monitored by this 

data source 

Unit Match 

code 

The match code of the reporting unit for this data source. This will 

default to the name of the county or reporting unit, but may be 

changed as needed. 

Only the Active and Match Code columns can be edited from this screen.  Clearing either 

entry removes the reporting unit and checking the Active column adds it back again. 

Click [Back] to exit this screen and return to the chosen data source. 

 

Data Source Update Log 

To see a log of the updates posted from a particular data source, go to the ‘Update Log’ for 

the chosen source. 

If data has been received and posted, a screen similar to the following will display: 
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The update log is made up of the following columns: 

# The number of the update 

Time The time the data was updated 

File Name The name of the xml file containing the data 

#Races The number of races updated in that story. A race is not updated unless 

the results have changed. 

Details The name of the story provided by that source 

 

The list may be filtered by the number of files shown and when the files are received. 

 

The list may be further filtered by specifying key words in the details. 
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Note that the number of files displayed has changed, limited to 13 files. 

Clicking on a particular story gives further details, as shown below: 

 

  

Loading Races 

Loading race data from the data source allows for the quick setup of races, ensuring that all 

match codes correlate with the data source. Data may be loaded directly from the data 

source or from a spreadsheet containing the race and candidate information. 

From the Data Sources screen, click the data source from which to load races. 

Select whether to load races from: 
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a [Data] source which already contains preliminary test data 

-or- 

a [Spreadsheet] which contains the race and candidate information 

 

 

 

 

Loading Races from an Existing Story 

If [Data] is selected, the following screen is shown. The [Search] button is highlighted in red 

indicating that a search has not yet been performed using the given parameters. 
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Additional search criteria can be selected for stories received during a particular time range, 

or containing specific text. There is also an option to "Show All Stories" rather than just the 

latest story with a particular slug. 

Select the date for which to load races from the data source.  

When options have been chosen, click [Search]. 

If any stories are found, a screen similar to the following will display: 
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All the stories meeting the search criteria are shown in the list on the right side of the 

screen. 

Click a story to view the race and candidate information from the story.  

The screen changes to show the relevant information. 

 
 

Depending on the source, there are two or three tabs shown at the bottom left of the 

screen.  

The 'Races' tab shows Race and Candidate details on the left side as well as the Link / Load 

Status and details of the Race / Candidate matches that have been made. 

The 'XML' tab shows the story after it was converted from the raw AP text to an XML text 

file. These additional tabs are made available for investigative purposes, if needed. 

The ‘AP Story’ tab (only shown for AP data sources) shows the contents of the story as it was 

received from the Associated Press.  

When a race is selected on the ‘Races’ tab, it is highlighted in yellow and buttons appear on 

the right side of the screen. 
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A race is ‘Linked’ when the race name is matched / connected to a specific contest in the 

Election database. At this point the database has not been updated with any details.  

A race is ‘Loaded’ when all the race and candidate details have been updated into the 

database. 

 

When a race is selected on the 'Races' tab, buttons are made available on the right side that 

relate to this specific race. In the case above, District 12 is already linked, so the options are 

to [UnLink] it or [Load] the data. If the race were not already linked, then the only button 

available would be [Link], as shown on the previous screen. 
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Linking a Race in the Story to the Database 

First, select the race to be linked. The only available button is the [Link] button, as the race 

needs to be linked before it can be loaded. 

 
 

Clicking [Link] brings up the Link Contest to the Story screen. 
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This screen allows the user to select an existing contest in the database to link to the 

selected race (District 1 in this case) or to [Create a New Contest] to be linked to the story.  

Races in red have been linked already, races in blue have been set up in the current election 

already, and races in black are contests in the database which are not in the current election. 

(Races in black are only shown when the “Show Active Election Only” check box is not 

checked.) 

Highlighting different races shows the existing connections for other data sources, if 

applicable.  

Select a contest (in this example, TN US Rep Dist 1), and then click [Link to this Contest] to 

create the link between the story and the database.  

 

 

 

The following screen will display: 
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US House District 1 is now linked.  

Once linked, the buttons on the right side also change to show new options, namely 

[UnLink] and [Load]. 

The data can then be loaded by clicking the [Load] button. Clicking [Load] causes all the 

relevant data in the story to be updated in the database.  

Once loaded, the buttons on the right once again change to show the options to [UnLink] 

and [UnLoad]. 
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The 'Load' process must be completed in order to load candidate information and match 

codes.  

If the candidate names don’t match, a screen similar to the following will display: 

 

Notice that the name in the pink box is spelled differently than the name supplied by the 

data source. If the candidate name is selected on the right, the new spelling will be added as 

a match to the original spelling. If [Add Candidate] is chosen, the original spelling supplied 

by the data source will be retained.  

If the contest to be linked cannot be found in the system, then the [Create a New Contest] 

button is clicked to bring up the Add New Contest display as shown below.   
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The contest details need to be confirmed before clicking [Save] to create the Link.  

 

Loading Race Details from a Spreadsheet 

If the [Spreadsheet] selection was made on the Data Sources screen (Main screen > [Setup] 

> [Data Sources]), the following screen is shown, with some entries being based on the race 

and candidate parameters. 

 

 

This function enables the user to build one or more spreadsheets with race and candidate 

information and load the data into the system very quickly. The spreadsheet can be edited if 

needed and the data loaded again.  

 

The spreadsheet may also be generated by the application from the Maintain Races screen 

in the following section.  

Any of the columns displayed in the screen above can be used as column headers for the 

spreadsheet.  Races can be separated in the spreadsheet by blank lines if needed.  

Note: The first candidate for each race should be on the same line as the race 

information. 

Click [Browse] to locate a previously constructed spreadsheet file (suffix .xls or .xlsx) or a tab 

delimited file (suffix .txt) that contains race data. The spreadsheet should not use any 

background coloring as this is how the matching information is shown by the application.  
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Make sure the spreadsheet is not already open when selected from the [Browse] button. 

Once the appropriate spreadsheet is located, click [Open] and a screen similar to the 

following should display: 

 

 

The Yellow column headings indicate that the application has identified them as legitimate 

data columns.  The green race row headers indicate that the data has been matched to a 

race in the election. If the race name was highlighted in red it would indicate that the race 

name was not found and a message in red would be displayed (see lower right). 

Click [Browse] to select another file to process. 

Click [Next] to continue if all the race information is correct. Otherwise, edit the spreadsheet 

and repeat. 
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Set the following parameters on the screen for the update process. 

Data Source The source can be changed at this time, if needed 

"Update Race Match 

Codes" 

Check this if the entries in the sheet should update the application 

data (if ‘Race Match Code’ column is present) 

"Delete ALL Candidate... 

before loading New Data 

This confirms the action about to take place 

"Update after matching to 

the Candidate Name..." 

Check this if the entries in the sheet should update the candidate 

details, and the criteria for identifying the candidate 

"Update Candidate Match 

Codes" 

Check this if the entries in the sheet should update the candidate 

data (if  ‘Candidate Match Code’ column is present) 

 

Click [Back] to return to the previous screen and load another file.  

Click [Load Races] to update the database when the results screen is displayed, as shown 

below. 
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Notice the comments on additional candidates on the second race and the statistics at the 

foot of the screen. 
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5 

Maintaining Race Details  

This section describes how to use the Races screen to update race information, including: 

 Adding, editing, and deleting candidates 

 Customizing race parameters 

 Viewing jurisdiction and source information for a specific race 

This routine is typically used prior to Election Day to refine the data and check for 

inconsistencies. 

It is also used to load details of races that need to be entered manually if the details are not 

being loaded from a spreadsheet. 

To access the Races screen, start at the Main Menu and click [Races] or Edit > Maintain Race 

Details. 
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The Races screen displays.  

 

The race numbers and names are shown in the left panel. The right panel shows information 

about the race, accessed by four separate tabs. On this particular screen, no candidates 

have been entered.  

When a different race has been chosen, the information for that race is displayed, as seen 

below. 
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A pre-defined race list may be chosen from a drop down list to view the specified races 

within those lists. Click the ellipsis button [...] at the upper left of the screen to set up a new 

list. See ‘Maintaining Lists For On-Air Display’ in Chapter 4 for more information. 

In addition to manually maintaining the candidates in a race, the candidate display can also 

be rearranged to show notes on the candidates by checking the "Show Notes" checkbox 

under the Candidate list. 

Along the bottom of the screen are some additional buttons that may be available to the 

user. These are described later in this chapter. 

Adding and Modifying Candidates 

The 'Candidates' tab displays the list of candidates loaded for the currently selected race.  

The user can add, edit, and delete candidates as well as change the order of candidates on 

a ballot or transmission. 

The following table describes the 'Candidates' tab columns. 

# The order the candidates appear on the voting 

ballot 

Candidate  Name of candidate 

Party or Pty Political party affiliation 

Incumb or I Indicator displaying whether the candidate is the 

incumbent office holder in the race 

Favorite or F Indicator displaying whether the candidate has 

been marked as the favorite to win the race 

Parameters  An abbreviated view of the custom parameters 

that have been set up for the election 

Notes If "Show Notes" is checked, then candidate notes 

are shown on the screen in place of the 

parameters, and the columns and column 

headings are rearranged. 

 

Adding Candidates 

To add candidates to a race, start from the Races screen with the 'Candidates' tab open and 

highlight the desired race in the list by clicking it. Then click [Add]. 
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The New Candidate search screen displays showing the names of candidates that have been 

marked "Keep Personal Details on File" (see below).  Names in red are already loaded in this 

race and cannot be selected again. 

 

To add a candidate whose personal details are on file, click an existing name on the grid. 

Notice that the responses to non-office races (yes/no, for/against, etc.) are listed as 

candidate names. 
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To locate an existing candidate in a long list, enter the candidate’s last name. As the name is 

typed, the screen list is reduced accordingly.  

 

Select an existing name in the list or enter a new last name and press [Enter] 

The New Candidate screen displays. 

 

 

If a new candidate was entered, enter the candidate's personal information, if desired. 

Click the “Keep Personal Details on file” check box in order to save the candidate 

information for the next election. Otherwise, this information is discarded when the election 

details are cleared.  

Click the “Incumbent” and “Favorite” check boxes if either applies.  

Add notes as necessary.  

Enter values for custom parameters if applicable. 

Click [Save]. The candidate will then be added to the race. 
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Editing / Removing Candidates 

To edit a candidate, start from the 'Candidates' tab located on the Races screen.  

 

Select the candidate to edit and click [Edit] or simply double click the candidate.  

 

The Edit Candidate screen displays, which is almost identical to the New Candidate screen. 

 

After making changes, click [Save].  

To remove a candidate from a contest, select the candidate to be removed, and then click 

[Remove].  

*Important Note: If a candidate's details have been retained (see New Candidate or Edit 

Candidate screens above), the candidate will remain on the available list of candidates, even 

though the candidate has been removed from a race. Otherwise, a candidate will be 

permanently deleted when removed from a race. 



Election Voting Attendant User Guide 7.6 

Business Technology, Inc. Rev. Aug, 2021 75  

 

When asked to confirm, click [Yes].  

Changing the Listed Order of Candidates 

To change the order in which the candidates are listed in a contest or race, select the 

candidate to be re-ordered.  

Click the [Up] or [Down] button to place the candidate in the preferred position. 
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Customizing Race Details 

The 'Race Details' tab is used to customize details about a specified race. 

To customize details, start from the Races screen, select the race to be customized, and click 

the 'Race Details' tab. 

 

The following table describes the 'Race Details' tab elements. 

Race Number Any number assigned  to a race for reference purposes 

"Include Race in 

Transmission" checkbox 

This is checked by default and would only be 

unchecked in cases where the race should not be put 

on air. This option should be used with caution. 

Race Notes Additional notes for the race 

"Set race winner 

manually” checkbox  

Determines that the winner of the race will only be set 

or cleared manually and that any incoming data 

source information on the winner will be ignored. If the 

race winner is marked manually in the producer’s 

Status screen, then this flag is automatically set. 

“Set Race Winner 

Automatically…” checkbox 

Determines the winner automatically when 100% of 

precincts are in 

Race has [#] Candidates This section allows a user-defined limit to the number 

of candidates which will show on Full Screen and 

Lower Third transmissions. 
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"Candidate Vote 

Percentage... Override" 

Voting percentages are normally rounded to equal 

100%. An entry in this box will determine the precision 

to which rounding will occur. 

Custom Race Parameters Race parameters that are specific to this election setup 

 

After changing any race details, click [Save]. 

 

Race Jurisdiction Information 

The 'Jurisdiction' tab displays race information about the voting area covered by this race, if 

the information has been set up in the application (see Chapter 3, 'Jurisdictions' tab). This 

would include the number of registered voters, expected number of voters, and number of 

precincts for the race as a whole, along with each constituent county or part thereof. 

 

 

The following table describes the Jurisdiction tab elements:   

Reporting Unit County name (or parish/ward, etc.) - this is the Reporting 

Unit. 
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Voters Number of registered voters from that county who are 

eligible to vote in this race 

#Expected Using the percentage of voters expected to vote, as provided 

by the county, the expected turnout is calculated 

Precincts Number of precincts that have this race on the ballot 

Override If the number of precincts is manually overridden, the total is 

shown in the "Override of the Total# of Precincts" field  

The totals of the above jurisdiction elements are displayed to the left of the table. This level 

of detail can only be shown if set up in the application. 

 

 

Data Source Information 

The 'Sources' tab displays the data sources that have been set up to gather results for the 

race and its corresponding race and candidate match codes. 

 

 

The data sources are listed in the center panel. When a source is selected, the area located 

below the center panel displays the level of reporting for the data source. The right side of 

the screen shows all the match codes currently set up for the race for this source. 

When results are received from an electronic data source, there is always a matching 

process to identify the race itself and then each candidate within the race.   
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Some electronic sources, such as the AP wire, require two identifiers to match a race—first 

identify the AP Wire story using the story slug (APWire-MultiRace) and then the specific race 

(e.g., Secretary of State) within the story. Most data sources only need "Race Code 1" set up. 

The candidate match codes vary slightly from each source; some use the last name only and 

some include the first name and candidate’s initials. This screen permits viewing and editing, 

if necessary, the match codes for both the race and the candidates.  

Note: While the match codes can be changed here, the recommended practice is to use 

the appropriate "Load Races from" button on the Data Sources screen of Maintain 

Election Details, where possible. This will automatically load the candidate and match 

code details from test data or a spreadsheet. See Chapter 4, Configuring Election Details, 

sections "Maintaining Data Sources" and “Loading Races” for more information. 

To edit a match code, click the grid and enter the preferred match code. 

 

Click [Save] to keep any changes. 

The Match Codes group box allows all match codes for the race to be set (or cleared) at one 

time.  

To fill all the blank match codes for the race, select whether the candidate match code uses 

Full Name or Last Name. 

Click [AutoFill].   

 Note: Any existing match codes are left alone. 

 

The match codes will automatically be filled into the appropriate fields. 
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If all match codes are assigned in this race for this source, then only the [Clear] button is 

available. 

Click [Clear] to clear the Candidate match codes. 

To clear the Race match codes in addition to the Candidate match codes, check the "Race?" 

check box, then click [Clear]. 

 

Other Functions 

There are several other functions available using the buttons along the bottom of the Races 

screen. 

     [Consistency Check] Button 

The consistency check procedure performs a variety of validations of the data that was set 

up for the election and highlights any inconsistencies that it finds, counting both the 

warnings and errors. 

The [Consistency Check] button is always available on the Races screen; selecting it causes 

the following screen to be displayed: 
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Indicate whether the checks should be applied to races and/or data sources and click 

[Proceed]. 

 

After performing a full analysis of the system, a screen similar to the following displays: 

 

Any exceptions found may be reviewed and printed. When run just prior to the election, no 

errors should be located by the process. 

     [File Search] Button 

The [File Search] button is an analytical tool that searches historical results information for 

postings that relate to this race from one or more sources. This process relies on the fact 

that each discrete capture of results, which can include one or many race results, is stored 

on the BTi server.  
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Click the [File Search] button to display a screen similar to the following: 

 

Enter the search criteria using the available search options on the left side of the screen.  

Click [Search] to initiate all the related entries.   

If any files are found, the screen will look similar to the following: 
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In this particular case, Election Bridge was the only Data Source that returned any files with 

the given search criteria. 

 

     [Export Races] Button 

This button gives the option of exporting some or all races in the election to an Excel 

spreadsheet. 
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Select the races to be exported using one of the pre-built race lists, or select ‘All Races’. 

 

 

When the [Export Races] button is clicked, a spreadsheet of all the races on the Races screen 

is created with columns for all the pertinent race information.   

 

 

Enter the name and path of the file to be exported, or browse to another location. This 

enables the [Proceed to Export] button.  

Click [Proceed to Export] to create the spreadsheet in the location specified.  
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     [Go To Contest] Button 

 

This button changes the screen to show the selected race in the Maintain Contests screen 

described in the previous chapter.  

 The Maintain Contests screen has a similar button which toggles back to this screen. 
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          6 

Entering Race Results 

Race results may be entered manually or automatically. Results are entered manually using 

the Update Race Results screen.  

From the Main Menu, click [Update] or click Edit >Update Race Results. 
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The Update Race Results screen displays. 

 

 

 

The screen consists of a list of races which is defined by the Data Source and/or the Race 

List selected at the top left of the screen. 

At the top right of the screen are two checkboxes. When checked, the one marked "Show 

the Latest Voting Results" will display the latest voting information from any data source on 

any races which have been expanded to show candidates. Click on a specific race to expand 

it to show the candidate information.  

The other checkbox is marked "Auto-Advance to next Race". This may be used to speed up 

the data entry process by automatically moving to the next race in the list after data entry 

for the previous race has been completed. Simply press the <Enter> key. 

Entering Race Results 

First ensure that the correct Data Source is selected, then select the race to be updated. The 

screen adjusts to highlight the race, show the candidates for the race, and show the buttons 

to [Enter Votes] and [Set Winner]. 

The list of races can be reduced by assigning the data entry workstation its own Race List to 

update, which is selected from the drop down Race List.  
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There is a red dot shown in the Race name box. Hovering the pointer on this dot will display 

additional information about the race, including the district and the number of registered 

voters. 

 

Click [Enter Votes] to be guided through the entry of votes for each candidate in the pink 

box. The text on the buttons changes accordingly. 

Press <Enter> or click [Next] to move to the next candidate, as shown below. 

Press <Esc> or click [Back] to return to the previous entry. 
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When votes have been entered / updated for each candidate, the prompt moves up to 

enter the number of precincts reported. 

 

This entry is followed by the Total Number of Precincts. If no change is needed, press 

<Enter> to accept the current value. That completes the entry of results for this race. 

If "Auto-Advance to Next Race" is checked, then the next race in the list is presented, as 

shown below. 

 

Press <Enter> again to take the default entry and start entering votes for this race. 
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As each race on the screen is selected, it is expanded to show the candidate and voting 

information.  A race can be minimized again by clicking on any of the [<<] boxes by the 

candidate names. The race maintains its pale yellow coloring to indicate that it has been 

opened.  

Setting the Race Winner 

To set the race winner, select the race and then click the [Set Winner] button. 

The leading candidate will be offered up as the winner of the race, to be accepted or 

declined. If declined, the candidate with the next highest number of votes will be offered up. 

If more than one winner has been declared for a race, then the top candidates will each be 

offered up in turn. Once the appropriate number of winners has been declared, the process 

terminates. 

 

 

The [Set Winner] button is also used when a winner has already been declared and the user 

wishes to override the winner previously declared or to declare no winner.  

The system will ask if the setting should be changed for the currently declared winner.  

Click [Yes].  

As each candidate is offered up as the winner, click [Yes] for the new winner or keep clicking 

[No] if no winner is to be declared. 

 

Entering Race Results by County 

To enter results by county, a manual entry data source needs to be created. Refer to the 

"Maintaining Data Sources" section in Chapter 4.  

 

When this data source is selected, a screen similar to the following is displayed.  

County information (or Parish, Ward, etc) is now included in the display on the right side of 

the screen. 
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Select the county for which results are to be entered, and proceed to enter votes as 

described previously.  

Note that votes cannot be entered until a county or reporting unit is selected. When 

selected, only the races pertaining to that reporting unit are displayed. 
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Check "Show the Latest Voting Results" to display the latest results from ALL data sources. 

For example, the AP FTP site may be updating faster than manual entry.  

 

 

Only races that have been expanded will show results.  
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7 

Viewing Voting Results 

The Voting Status screen is used to: 

 

- View a voting summary by source for a specific race  

- Manually set a winner for a specific race  

- Re-evaluate election results  

- View voting details for all data sources for a specific race  

- View voting results history  

- Insert races automatically or manually into running transmissions and display them on air 

immediately 

To access the Voting Status screen, start at the Main Menu and click [Status] or select List 

>View Election Status. 
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The Voting Status screen displays.  

 

This screen, along with the series of screens it opens, is used on election night by producers 

to monitor race results as they are received.  Also, if needed, on-air transmissions such as 

cut-ins and the election ticker can be controlled in real-time. 

The screen is divided into 4 main sections: 

- A list of races with associated information on the left side 

- A list of candidates for the selected race on the upper right side 

- Information related to the selected race in the lower central area 

- A series of 5 buttons on the lower right side offering other election status screens, 

including views of the results and on-air control 

The race list located in the top left corner defaults to ‘All Races’ but any list of races can be 

selected.  Building lists of races for analyzing the results ahead of time allows users to switch 

between groups of races very quickly. 

If configured for the user, an ellipsis button is displayed to allow lists to be built from this 

screen.  

For a more detailed explanation of lists, see "Maintaining Lists" in Chapter 4. 

Select the race to be displayed from the list on the left. When first entering the program or 

when a new list is selected, the first race in the list is automatically selected. The selected 

race has its race number highlighted in blue and the race name is bolded. 
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The Race Grid 

The following table describes the contents of the race grid in the left panel. 

# Race number 

Race Name of the race 

%  Percentage of precincts reporting or “All”.  If the [Precincts] button 

below the list is clicked, the percentage of expected voters displays 

here (if the data has been set up). See the note later in this chapter for 

more information on percentages. 

W “W” indicates a winner has been declared for the race.  “u” indicates 

that the favorite is not in the lead (upset). “m” indicates that the "Race 

Winner Manual Override" is set. 

Upd The last time any results were received for the race 

Aired The last time the race results were aired 

Grid Color When a new result for a race is received, the race turns red in the grid.  

As the result gets older, it fades to yellow. If no votes have been 

received, the race remains white. 

These descriptions are displayed in brief below the race list.  In addition, the “%” line 

description includes the button described above that flips between [Precincts] and [Votes] 

to indicate what values are represented in the “%” column. 

The row color in the race grid is white if no results have been received. When new results 

are received for a race, the color of the row turns red and as the results become older, the 

color of the race fades to yellow. This color scheme acts as a visual indicator of the latest 

results received. 

The column headers of the race grid can be clicked to sort the data. Each click changes the 

sequence from ascending to descending to the original sequence. 

 

The Candidate Grid 

The following table describes the candidate grid in the upper right panel of the screen 

Ballot Order of the candidates on the ballot 

Candidate Name of the candidate 
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Party/I/F Candidate party affiliation, followed by indicators for Incumbent and 

Favorite status. 

#Votes Number of votes for the candidate. These numbers would be put on 

air in a transmission. 

% Percentage of the total votes for the race that the candidate 

received.  

W  Indicator that the candidate has been declared the Winner.  Three 

asterisks (***) indicates which candidate is leading. 

Notes Any candidate notes that have been entered. Click the "Show 

Candidate Notes" button below the grid to reformat the display to 

show more of the candidate notes. 

 

Race Information 

 

Below the candidate grid is more information about the status of the voting for this race, 

including: 

Date and time of the last update to the race  

Date and time that the race was last aired (not shown above)  

Whether the Race Winner is under manual control  

Precincts reporting and total number of precincts  

Total votes cast  
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Update alerts or warnings (not shown above)  

Any race notes that have been entered  

Jurisdiction details, including the number of registered voters, the expected 

voter turnout and the percentage of voters of each  

A red alert for ‘Test Mode’ to indicate that the application is being set up and 

that races without votes will be aired.   

Note: This setting should be cleared before election results come in using File > 

EV Options > ‘Reset’ tab – see the section on the ‘Reset’ tab in Chapter 3. 

Other Election Status Screens 

The other status screens are: 

Voting Analysis – shows a breakdown of the latest results from each data 

source and highlights those selected for air. It also includes the ‘Set Race 

Winner’ feature. 

Voting Details – itemizes the latest postings received from all sources and 

allows an individual posting to be excluded from the results.   

Results History - shows a log of all the postings and updates to the results for a 

race, which can be sorted by data source, time or by county (if applicable) 

Ticker Inserts – allows a race result to be inserted into a running ticker on-the-

fly, kept on air if needed. 

Manage Cut-Ins – allows a cut-in list of races to be put on air and controlled, 

allowing for those immediate exceptions. 

The first three screens listed above follow the race selected on the main election status 

screen. The screens can all be opened at once and arranged on the display as needed, with 

data refreshing real-time. 

The last two screens allow transmissions on-air to be controlled directly and independently 

from the main screen. 

Select one or more of the screens from the above list, which are described in more detail 

below. 

 

Voting Analysis 

For the race selected on the main Status screen, the Voting Analysis screen shows the 

breakdown of latest results from all data sources and highlights in green the best results 

that were selected for airing. It also includes the ‘Set Race Winner’ feature.  
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The grid can be broken down into three sections separated by heavy lines. 

The top section shows the best set of results received so far. It includes numbers for each of 

the candidates, along with their percentage of the vote. The candidates are arranged in 

descending order by the number of votes received. The total votes cast are shown along 

with the time that the results were received, as well as precinct information. 

The middle section shows a row of similar information as it was received from each data 

source. The first three lines in the example (APWire-Contested, APWire-TopRaces, and 

Called-In Election Results) relate to data sources that post results by race. The fourth line 

(Reporting Units Total) represents the best results that were assimilated from all the data 

sources that post at the reporting unit level (County). 

The lower section would only be present if county, or other reporting units, were posted. It 

shows an entry for each county, which is the ‘best value’ for that county. In the example, 

there are two data sources reporting by county (Results from County Seat and Metro Area 

County Results). "Results from County Seat" had the best results for all the counties except 

Rutherford County which used "Metro Area County Results". 

The green highlight on the Reporting Units Total indicates that it was the set of values that 

was selected for the race, and as such was repeated in the top section. This comparison was 

based on the total votes cast from each of the sources, the 58,290 from the "Called-In 

Election Results" exceeding all the other entries.  

A [Print] button provides a hard copy printout of the grid in the display. 

A Race Winner panel is also available and is described below. 
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Setting the Race Winner 

To manually set a winner for the race (if it does not already have a winner marked), click the 

[Set Winner] button at the lower left of the screen. 

The system evaluates the votes cast and displays a prompt asking if the leading candidate 

should be declared as the winner.  Click [Yes] to accept the choice and declare the winner.   

 

Clicking [No] displays a prompt asking whether the next candidate is the winner.  

Keep clicking [No] or click [Cancel] if no winner is to be declared at this time. 

The Voting Analysis screen displays the newly declared winner in bright green. 

 

The [Set Winner] button is also used to clear a declared winner; simply follow the prompts. 

Note: The "Race Winner Manual Override" check box is set.  Whenever the winner status 

is manually set or cleared, this check box is set automatically. It prevents another data 

source, perhaps the AP feed, from changing the winner status that has been set manually.   

The indicator for "Race Winner Manual Override" can also be set on the 'Race Details' tab 

of the Races screen described in Chapter 5. 
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Voting Details 

For the race selected on the main Status screen, the Voting Details screen itemizes the latest 

postings received from all sources and permits an individual posting to be excluded from 

the results.   

 

By default, the results are shown first for all the data sources that report by race, followed by 

a section for each of the reporting units or counties. This allows the results for each county 

to be visually compared easily, and the entry with the highest votes cast is shown in the 

Voting Analysis screen. 

In the event that two results have the same number of votes, the first entry posted to the 

system is used. The time stamp shows the last time that the race numbers were confirmed. 
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Setting the "Group By Source" checkbox causes all the entries to be arranged by data 

source, as shown below. 

The screen below shows the "Called-In Election Results" entry selected, causing it to be 

highlighted in yellow and enabling the [EXCLUDE Result] button. This button causes the 

voting results for the Vice Mayor race from "Called-In Election Results" to be excluded from 

the best results evaluation process, if so desired, and is described in more detail below. 

 

 

A [Print] button provides a hard copy printout of the grid in the display. 

Excluding a Bad Result 

This action is likely if a bad result has been posted, either electronically or by manual entry, 

and the numbers need to be removed immediately.  

 

Select the data source from which the numbers need to be excluded from the best results 

calculation. The entry is highlighted in yellow as shown above. 

When the [EXCLUDE Result] button is clicked, a confirmation screen is displayed. 
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Click [Yes] to confirm that the result is to be excluded. 

All postings for the selected race are re-evaluated and the entry is marked as EXCLUDED 

and highlighted in light blue on the Voting Details screen as shown below. 

 

 

 

The other screens are also refreshed. 
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In the example above, the re-evaluation caused a different set of results to be selected as 

the best figures for airing. By excluding the Called-In Election Results, the next best set of 

numbers was the sum of the best results from each individual county, which is now 

highlighted in green on the Voting Analysis screen. 

When the data is corrected, the results can be included back into the best results evaluation 

process by selecting the data source again and clicking the same button, which now shows 

as [Include Result].   

 

Results History 

The Results History screen shows a log of all the postings and changes that have taken 

place in the race from all data sources, and allows the results to be sequenced in various 

ways. 

Clicking a specific entry in the display highlights the entry in yellow and provides additional 

details in the grid shown below. In the case of a manual entry result, it shows who entered 

the data and from what workstation. In the case of an electronic posting, it shows details of 

the file from which the data was received and, if still available, provides a button to show the 

actual results file (story) received. 
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Each row of data in the report represents a set of results for the race. When displaying the 

screen, these results are shown for each data source in turn. But the Order Results By group 

box also allows the data to be shown in "County" or "Date/Time" sequence. 

The Order Candidates group box gives the option of sorting the candidates by leader or by 

ballot. 

 

Click the “Only Show Results” check box to show voting results without including the text on 

the various actions which have affected the race.  

The screen above was shown with the box checked, but in the example below, the box has 

been unchecked and the blue entry shows the setting of the race winner. Any other action 

related to this race is also logged in this manner. 

 

 

 

Clicking the [Show Story] button (when present) opens a window with the story text as 

received from the data source.  
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By default, duplicate postings are not shown on this screen. The time stamp shows when 

results were first received. Subsequent entries will not be shown if the numbers do not 

change.  

Click the “Show Duplicates” check box to show every result that has been received , 

regardless of whether or not the numbers have changed.  

 

 

 

A [Print] button provides a hard copy printout of the grid in the display. 

Click [Close] to exit the screen.  

  A Note on Percentage Calculations:  

Percentages are calculated with a single routine that has 3 arguments: the Total Value, the 

Proportionate Value and the number of decimal places. 

The percentage of the Proportionate value (or Portion) to the Total is first calculated to the 

number of decimal places.  

A lower limit check is then applied. If the % is zero but the Portion is more than 0, then the 

percentage must be more than 0; so the lowest decimal point of the result is incremented 

by one.  

An upper limit is then applied in the same way. If the % calculates to 100% but the Portion 

value is less than the Total, then the lowest decimal point of the result is reduced by one. 

In other words, if the upper limit check finds that the portion (# of votes) is one vote less 

than the total (Expected # of Votes) then the highest percentage is 99%, or 99.9% or 

99.99%. 
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For example, if 1000 votes are expected and total votes returned is 999, then the percentage 

will be 99.9%. If the total is 1,000 or more, the percentage is 100%. (The total cannot exceed 

100%.) 

Ticker Inserts 

The [Ticker Inserts] button opens the Control Race Inserts screen from which the user can 

manage an automated Lower Third Ticker and insert one or more races into the active 

transmission, holding them on screen if needed. 

Note: The transmission must be marked as a “Ticker” to allow control from the Control 

Race Inserts screen. This may be done, if necessary, by editing the settings in the job's 

Content screen within the Transmission Status screen. 

 

The race list in the top left corner defaults to ‘All Races’, but any list of races can be selected. 

Building lists of races ahead of time will allow users to switch between groups of races very 

quickly.  

 

If configured for the user, an ellipsis button will be displayed to allow lists to be built from 

this screen.  

For a more detailed explanation of lists, see "Maintaining Lists" in Chapter 4. 

 

 

 

Select an active transmission job from the 'Available Active Transmissions' list. If there is only 

one entry, it is selected automatically. Click [Refresh] if necessary to refresh the list. 

If the list is blank, go to the Transmit screen and make sure the ticker is running. 
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A connection is made to the transmission such that the currently aired race is shown on the 

screen in the middle of the right hand panel, along with the next race about to air, which is 

shown in a pale orange.  As the transmission continues, this information is updated. 

Select a race from the left panel and then click the [Add] button to add the race to the 'Race 

Inserts' list, or just double click the race in the left panel.  

Click [Apply Insert] to put the race on air.  It is inserted into the transmission after the race 

currently highlighted in pale orange. 

An indicator at the upper right of the screen displays while the insert is going to air. 

Click the [& Hold] or [Once] button to select whether the race stays on air until cancelled, or 

only appears one time. By default, the race stays on air until released. 

 

 

Once running, the [Apply Race Insert] button changes to [Cancel Race Insert]. Click this 

button to release the race from the ticker. (This is only necessary if the ‘& Hold’ option is 

selected.) 

The transmission continues with the next race in its sequence as if nothing had happened. 

The Race Insert list can be built again and more races inserted into the transmission. Use the 

[Remove] and [Clear] buttons along with the [Add] button to build additional insert lists. 

 

Manage Cut-In 

The [Manage Cut-In] button opens the Manage Cut-In Transmission screen, from which the 

user can manage a manually controlled full screen cut-in transmission which has already 

been activated. It allows selection of races for airing sequentially or in random order from 

the race list.  
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Note: The transmission must be marked as a “Cut-In” to allow control from this screen. 

This may be done, if necessary, by editing the settings in the job's Content screen within 

the Transmission Status screen. 

The race list in the upper left corner defaults to ‘All Races’ but any list of races can be 

selected. It is suggested that a list of races be built in advance for each Cut-In to make the 

operation of this process easier. If configured for the user, an ellipsis button will be 

displayed to allow lists to be built from this screen.  

 

 

Select an active transmission job from the Available Active Transmissions list.  If there is only 

one entry, it is selected automatically. Click [Refresh] if necessary to refresh the list. 

Select the Cut-In list from the list of races. The planned list of races displays in the left hand 

panel. 

Normally the first race would be selected, but any race on the display can be picked. The 

race list can be changed at any time and a race from another list selected if needed. 

The “Only Show the First Page of Each Race” check box limits the on-air output to the first 

page of candidates of each race. 

Select the race to be inserted into the transmission. The race name displays in the "Next 

Race to go On-Air" field in green. 

Click [Go To Air] to transmit the race information to the assigned character generator 

device. 

The selected race is put on air and appears in the “Feedback – aired…” field.  

The next race in the list (which has results) is automatically selected and appears in the “Next 

Race to go On-Air” field. Another race can be selected at this time, if preferred. 
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Click [Go To Air] to display the next race. This process of clicking [Go To Air] can be 

continued through the list until the last race has been aired.   

In the example below, the transmission has been set to display only 2 candidates at a time. 

(See the section on transmissions, page 116.)  

 

To display the next 2 candidates, click [Go To Air] again. Repeat this action until all 

candidates have aired.  

If it is decided that the remaining candidates are not to be aired, use the [Cancel 

Candidates] button. Then use the [Go To Air] button to air the next race. 

Use the [Re-Start Race] button to begin airing the same race again from the top of the 

candidate list. 

Click [Take Off Air] to clear the race from the output. 

If new numbers have come in, click [RaceRefresh] to refresh the race results for all races. 

Click [Go To Air] to transmit the new results. 

Click [Close] to exit the screen.  
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8 

Monitoring Elections 

The Monitor process, also known as ‘Alert Logic for Elections’, is optional and is still under 

development. It is basically a retrieval and analysis tool that adds the capability of building 

custom screens for displaying election data using a race list; none of the data is changed. 

It gives the user the ability to set criteria so that the display can give a visual alert if a certain 

situation arises, such as if the difference between the top two candidates drops below 2%. 

It also has a printing capability so that race and candidate information can be printed in a 

user defined format. 

For more information on this process, please contact BTI. 
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9 

 Transmitting Election Results 

The Transmission Status screen is used to: 

View active transmission jobs  

Create new transmission jobs based on existing transmission jobs  

Activate, pause, and stop transmission jobs  

Edit transmission jobs  

 

To access the Transmission Status screen, start from the Main Menu and click [Transmit] or 

select File > Transmit Results. 
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The Transmission Status screen displays. 

 

 

Job List 

The display shows a list of transmission jobs on the right side of the screen, according to the 

selections made on the left side. 

 

 Note: In this application, the terms "job" and "transmission" are synonymous. 

The list of Devices on the top left of the screen shows devices for which jobs are available, 

as well as the status of the device and the port on which it is connected. Select a specific 

device to limit the job list display to that device only. 

The list of Applications on the left of the screen shows applications that have been installed 

on the server. Select a specific application to limit the list of jobs to that application. 

In the following example, the Election Voting application has been selected, narrowing the 

list of jobs shown. 
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In the lower left of the screen, custom Groups can be set up that contain a specific list of 

jobs for a particular user function. A group might be set up for each shift, for example. 

There are also three additional buttons available to the right of the application list: 

Show Active Jobs 

Only 

Limit the display to active jobs. 

Show Spots with 

Data Connectors 

This may be available if ‘Transmission Generator’ has been 

installed 

Show Hidden (*) 

Jobs 

Show jobs that have been marked as hidden. This is only 

available to administrators. 

 

The job list gives the following information and options for each job: 

Configure This button opens a screen to allow basic configuration 

information of a job to be changed.  

Content This button opens a screen allowing the content of the 

transmission to be changed. The screen differs depending on 

the job type. 
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Job ID The unique job number that represents a specific 

transmission or job.  

Job Name Name of the transmission job as created or edited by the 

user. The job name usually indicates or describes the type of 

transmission job.  

Device The device to which the job is assigned. 

Status Indicates status of the transmission: Active, Paused or Idle. 

Start Initiates a job if it is idle, or if active or paused, the job will be 

terminated. The button icon changes accordingly. 

Take Pauses or resumes a job depending on its status. The button 

icon changes accordingly. 

The following screen shows Job #EV25 has been activated and is running. Choices on the 

right include stopping or pausing the job. 

 

 

Configuring a Job 

When the [Configure] button is clicked to the left of a particular job, a screen similar to the 

following will display: 
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Job details can be changed from this screen, conditions set for the automatic termination of 

the job, and the job can be copied or deleted. 

A job must be assigned to a specific device (workstation, server, or CG) on which the 

transmission is activated. Choose a device from the ‘Assigned to Device’ drop down list. 

If needed, enter the time to stop this transmission and the number of cycles that this job 

runs. If these fields are left blank, the transmission runs continually until it is manually 

interrupted. 

When a job ends normally, it can link to another job. If this is to happen, choose a 

transmission job from the dropdown list to be activated when this one ends. 

Enter a priority value between 1 and 99, where 1 is the lowest priority and 99 is the highest 

priority. This value is used to prioritize jobs. If the priority value is blank or set to zero, the 

job is not included in processing of priorities. 

When a job with a priority is started, it executes in the same manner as before, but it also 

registers itself to the system. It is not until a second job with a priority starts that any 

changes are apparent. 

For example, if the Job 1 Priority is higher – Job 2 recognizes it should not be running and 

terminates itself. If both Jobs have the same Priority – Job 2 terminates. If Job 2 Priority is 

higher – Job 2 instructs Job 1 to terminate and then Job 2 continues.  When Job 2 is 

complete, it has the option to ‘Restart’ the job it terminated, namely Job 1. This happens if 

the Job 2 "Restart" check box is set. 

Note: Election Voting Attendant is capable of handling multiple job streams of separate 

priorities, as the case would be if the system is driving two character generators 

simultaneously.  Jobs with priorities for one CG, should not affect a job with a priority on 

another CG. By default, the name of the CG is used to control job streams, but other 

options are available if needed. 
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Setting the Job Content 

When the [Content] button is clicked for an election transmission job, a screen similar to the 

following will appear: 

 

Choose the races to be included in the transmission. Clicking the [Show Lists] button will 

display pre-defined lists that may be moved to the list of items to be aired on the right of 

the screen. Click the button again to return to the normal list of Races.  

Click [>>] to move all races to the list of items to be aired.  

Click [>] to move selected races to the list to be aired. (Multiple races may 

be selected at once using the <Ctrl> and <Shift> keys.) 

Click [<<] to remove all races to be aired.  

Click [<] to remove selected races to be aired. 

The same race can be included more than once in the list to be aired, and will then be 

repeated. 

The “Sort by # Votes” check box sorts candidates by their vote totals. 

The “Don’t sort Issues” check box excludes Issues type races when sorting by vote count.  

The “Only show the top {#} candidates” check box lets the user enter the maximum number 

of candidates that should be shown for each race. 

The "All Uppercase Output" check box will convert the output to all upper case if the 

present output is mixed case.   

Click the Up and Down arrow buttons on the right to change the order of a selected race in 

the list to be aired. 
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Select the appropriate Job Type: 

Ticker if the transmission job is a race ticker and may need to handle race 

inserts. 

TickerFS if the job is a full screen race ticker, not controlled by race inserts. 

Cut-In if the job is used for cut-ins. In this case, no jobs are assigned to the 

race because the race list and the individual races are assigned within 

the Manage Cut-Ins process 

Other is used for web page transmissions or other kinds of output. 

Click [Customize] to display the Advanced Transmission Parameters screen. 

 

The parameters and values shown will vary depending upon the nature of the transmission. 

Modify the transmission parameters as necessary and click [Close]. The changes will be 

saved. 

Click [Save Job] to save the modified transmission job. 

Click [Close] to return to the Transmission Status screen.  

 

Job Status Window 

Each active transmission job has a job Status window containing the current transmission 

activity and race information for the specific job. This window is available only on the system 

to which the job is assigned. 

 

The Status window displays the following transmission information: 
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Job name Name of the job, displayed in red 

Started at: Transmission start time and date 

Cycle# The number of times the data has been passed 

through 

#Processed: Number of records processed for the current 

cycle and the total number of records 

End of Cycle: The estimated time to the end of the cycle. (This 

will be blank if the job is paused.)  

 

Click [Resume] to restart the job if it is paused. 

Click [Pause] to suspend an active transmission job, selecting “Now” or the “At End” option 

to suspend the job at the end of the cycle. 

 

To stop the transmission, click [Stop Now]. 

The Status window can also be minimized if preferred. 
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10 

Viewing Reports 

The Reports screen is used to view and print Election Voting Attendant generated reports.  

To access this screen, start from the Main Menu and click [Reports] or select List > Reports. 
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The Reports screen displays.  

If the screen does not default to the Election Voting application, choose it from the 

Applications list. (This screen is common to all applications installed and allows reports for 

other applications to be selected.) 

 

 
 

Types of Reports 

The following table describes reports that are generated by the Election Voting Attendant.  

Other reports may also be available on your system. 

Report Description 

Election Report Complete listing of each race and candidate 

names as well as incumbent and favorite 

indicator sorted alphabetically by race 

Election Report by List Complete listing of each race and candidate 

names as well as incumbent and favorite 

indicator sorted alphabetically by race list name 
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Report Description 

Pre-Election Details by Race 

Number 

Listing of pre-election details including on-air 

titles, data source, candidate names, and party / 

incumbent / favorite indicators sorted by race 

number  

Manual Entry Form by Race Listing of manual ballot entries including race 

name, candidates, votes recorded, time taken, 

and number of precincts sorted by race 

Manual Entry Form by List Listing of manual ballot entries including race 

name, candidates, votes recorded, time taken, 

and number of precincts sorted by race list 

Manual Entry Form by 

Reporting Unit 

Listing of manual ballot entries including race 

name, candidates, votes recorded, time taken, 

and number of precincts sorted by Reporting 

Unit (County) 

List of Races by Race Number Listing of races including true / false indicator for 

air and manual control of race winner, and 

number of winners possible sorted by race 

number 

Races by List Listing of races including race number, true / 

false indicator for air and manual control of race 

winner, and number of winners possible sorted 

by race list 

Races / Candidates by List Listing of races, candidates, and party sorted in 

ballot number order by list name 

Election Results by Data 

Source 

For each race in turn, the candidate voting 

details are shown for each data source 

 

Viewing a Report 

Select the report to view from the list. 

Click [Execute]. 
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The report opens in a separate Report Viewer window. 

 

 

 

Printing a Report 

From the Report Viewer window, click the ‘Print Report’ icon at the upper left to display the 

standard Windows Print Dialog screen. 
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Saving a Report to a File 

From the Report Viewer window, click the ‘Export Report’ icon. 

 

 
 

An Export dialog box opens and provides a number of export formats, including:  

 Adobe Acrobat PDF 

 Crystal Reports 

 Html 3.2 

 Html 4.0 

 Microsoft Excel 

 Microsoft Word 

 Rich Text format 

 Tab separated text 

 Plain Text 

 

Select the type of file to be created and navigate to the destination location. 

Select a Page Range or all of the report. 

Enter a file name and click [Save]. 


